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Introduction

IBM® Predictive Customer Intelligence gives you the information and insight that
you need to provide proactive service to your customers. The information can help
you to develop a consistent customer contact strategy and improve your
relationship with your customers.

IBM Predictive Customer Intelligence brings together, in a single solution, the
ability to do the following tasks:
v Determine the best offer for a customer.
v Retain customers that are likely to churn.
v Segment your customers, for example, by family status and salary.
v Identify the most appropriate channel to deliver an offer, for example, by email,

telephone call, or application.

This solution ensures that all interactions with customers are coordinated and
optimized. IBM Predictive Customer Intelligence gives you the ability to sift
quickly through millions of customers and know who to contact, when, and with
what action.

The following steps define the process:
1. Understand the customer. Predictive modeling helps you to understand what

market segments each customer falls into, what products they are interested in,
and what offers they are most likely to respond to.

2. Define possible actions and the rules and models that determine which
customers are eligible for which offers.

3. After the best action is identified, deliver the recommendation to the customer.

Audience

This guide is intended to provide users with an understanding of how the IBM
Predictive Customer Intelligence solution works. It is designed to help people who
are planning to implement IBM Predictive Customer Intelligence know what tasks
are involved.

Finding information

To find product documentation on the web, including all translated
documentation, access IBM Knowledge Center (www.ibm.com/support/
knowledgecenter/SSCJHT_1.1.0).

PDF versions of the documents are available from the Predictive Customer
Intelligence version 1.1 product documentation page (www.ibm.com/support/
docview.wss?uid=swg27046802).

Accessibility features

Accessibility features help users who have a physical disability, such as restricted
mobility or limited vision, to use information technology products. Some of the
components included in the IBM Predictive Customer Intelligence have
accessibility features.
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IBM Predictive Customer Intelligence HTML documentation has accessibility
features. PDF documents are supplemental and, as such, include no added
accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References
to items that are not currently available may be included. No implication of any
future availability should be inferred. Any such references are not a commitment,
promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole
discretion of IBM.

Samples disclaimer

Sample files may contain fictional data manually or machine generated, factual
data compiled from academic or public sources, or data used with permission of
the copyright holder, for use as sample data to develop sample applications.
Product names referenced may be the trademarks of their respective owners.
Unauthorized duplication is prohibited.
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Chapter 1. Integration Example for Different Predictive
Scoring Models

This functional accelerator demonstrates how you can use models from two
different modeling tools in a real-time scenario.

It combines the real-time scoring capability of the Zementis ADAPA (Adaptive
Decision and Predictive Analytics) engine with the modeling of IBM SPSS®. In this
way, you can extend the library of available analytical and predictive models to
include any models that can be published in Predictive Model Markup Language
(PMML).

The functional accelerator simulates a customer's interactions through a channel,
such as a call center. The call center retrieves their profile and evaluates them first
for the propensity to churn and then for overall sentiment. The churn score from
the first model is used as an input for the second model, the sentiment analysis.

The sample begins at the point where the customer profile is retrieved. The churn
model is provided in PMML format and the sentiment model is provided as an
IBM SPSS model.

Functional accelerator flow
The Integration Example for Different Predictive Scoring Models functional
accelerator is run by using an IBM Infosphere Integration Bus (IIB) message flow.

After the functional accelerator is installed, the simulation is triggered by copying
a sample customer profile into a folder that is monitored by IIB. The sample input
file that is provided is named CustomerChurn_NN_100_rows.csv. It must be copied
into a folder that is named Zementis on the IIB node computer.

The file contains 100 customers. Each customer is processed individually by the
message flow. The output of the message flow is a customer’s sentiment score in
XML format, one file per customer. The score for the last customer to be processed
is in the Zementis folder. The scores for the previous customers are found in
separate files in the mqsiarchive subfolder.

Message flow

Figure 1. Message flow for the functional accelerator
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The Table 1 table provides the descriptions for each node in the flow.

Table 1. Message flow descriptions

Node name Description

File Input This node specifies the Zementis folder and file name pattern
CustomerChurn*.csv. It also specifies a data format definition
(DFDL) that defines the required CSV file format. Deviations
from the DFDL causes errors.

Flow Order This node specifies that the flow must retrieve ADAPA
credentials before the rest of the flow can proceed.

ZementisCredentials This node is a subflow that reads the zcredentials.properties
file from the restricted subfolder to obtain the ADAPA
credentials and stores the credentials in global environment
variables.
Note: The credentials are stored in long-lived variables and
can be changed only by redeploying the message flow or
starting and stopping the IBM Integration Bus server. The
subflow can be customized to read the credentials from a
database table instead of a file. For more information, see the
IBM Integration Bus documentation.

JavaCompute This node parses the incoming message from the CSV file and
prepares the outgoing message that is sent to the ADAPA
engine’s RPC service to get a score from the CustomerChurn_NN
model. The Customer Id is saved in the environment to be
used in the IBM SPSS model.

Error Subflow This node captures any issues with the CSV file format and
logs the errors in the failuremessage.xml file in the error
subfolder.
Note: Any earlier files of the same name are archived in the
mqsiarchive folder.

ZementisChurnSubflow This node executes the call to the ADAPA engine's RPC service
as a generic web service call. The SOAP request node specifies
the URL of the ADAPA RPC service.

Other nodes in the subflow include:

v Error Subflow captures problems with the Zementis
credentials and logs the errors in the failuremessage.xml file
in the error subfolder.
Note: Any earlier files of the same name are archived in the
mqsiarchive folder.

v Compute captures any SOAP errors and puts them in a file
that is named ADAPA_Error.xml in the error subfolder.

v SOAPExtract removes the SOAP envelope from the message
before the message is routed back to the main flow.

Flow Order1 This node directs the flow to get the IBM SPSS repository
credentials before the SPSS scoring call is prepared.

SPSSCredentials This node reads the scredentials.properties file in the
restricted subfolder to obtain the SPSS repository credentials
and store them in global environment variables.
Note: The credentials are stored in long-lived variables and
can be changed only by redeploying the message flow or
starting and stopping the IBM Integration Bus server. The
subflow can be customized to read the credentials from a
database table instead of a file. For more information, see the
IBM Integration Bus documentation.
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Table 1. Message flow descriptions (continued)

Node name Description

JAVA
Compute_afterResponse

This node parses the response that is returned from the
ADAPA churn model and combines it with the customer ID
and the inputs to the Churn model. Then, it creates a new
SOAP message for the IBM SPSS Collaboration and
Deployment Services scoring engine.

SPSSSentimentSubFlow This subflow executes the call to the IBM SPSS Collaboration
and Deployment Services scoring service as a generic web
service call. The SOAP request node specifies the URL of the
SPSS scoring service.

Other nodes in the subflow include:

v Error Subflow captures problems with the SPSS repository
credentials and logs the errors in the failuremessage.xml file
in the error subfolder.
Note: Any earlier files of the same name are archived in the
mqsiarchive folder.

v Process SOAP Error captures any SOAP errors and puts
them in a file that is named SPSSScoring_Error.xml in the
error subfolder.

v Java™ Compute after Sentiment Score captures the response
from the IBM SPSS Collaboration and Deployment Services
scoring service and routes the message back to the main
flow.

FileOutputAfterSPSS This node captures the customer sentiment score in XML
format and inputs it to the SPSSSentiment.xml file.

Adapt the functional accelerator
You can adapt the functional accelerator by modifying the message flow so that it
can be used as a web service call.

You can modify the nodes of the flow using the IBM Integration Toolkit client
application.

To adapt the functional accelerator into a web service call:
1. Replace the File Input node with an HTTP input node.

a. Under Input Message Parsing, specify the message domain JSON : For
JavaScript Object Notation messages.

b. Under Basic, specify a path suffix for URL, such as /PCI.
2. Replace the final File Output node with an HTTP Reply node so that the

sentiment score is returned to a web page in JSON format.
3. Edit the Java Compute after SentimentScore node, that is contained in the

SPSSSentimentSubFlow node, to create a JSON message format.
v Add a procedure such as the following just before the end of the module:

private void
httpReply(MbMessageAssembly inAssembly) throws MbException{
MbMessage inMessage = inAssembly.getMessage();MbElement body =
inMessage.getRootElement().getLastChild();
MbElement record = body.getFirstChild();
MbElement element = record.getFirstChild();
MbMessage alternateMessage = new MbMessage();
MbMessageAssembly alternateAssembly = new MbMessageAssembly(inAssembly,
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alternateMessage);
MbElement root = alternateMessage.getRootElement().createElementAsFirstChild("JSON");
MbElement data = root.createElementAsFirstChild(MbElement.TYPE_NAME, "Data",
null);

MbElement response = data.createElementAsLastChild(MbElement.TYPE_NAME,
"Response", null);

while (element != null) {
// Get the field name
// Get the value
String fieldName = element.getName();
Object value = element.getValue();
response.createElementAsLastChild(MbElement.TYPE_NAME_VALUE, fieldName, value);
element = element.getNextSibling();
}
MbOutputTerminal alternate = getOutputTerminal("alternate");
alternate.propagate(alternateAssembly);
}

4. Deploy the message flow to the IBM Infosphere Integration Bus server. The
message flow functions as a web service, available from the URL
http://server:port/PCI, where server is the IBM Infosphere Integration Bus
server name or IP address. The port is the port number that is used by IBM
Infosphere Integration Bus deployed applications. The default is 7080. PCI is the
URL extension name that is used in the HTTP Input Node in the message flow.

5. A web application is able to post a JSON message to the URL above in the
format of name-value pairs. The following sample illustrates the message body
using the exact names required, but the values may vary:
record={"TotalDollarAmountSpentMerchandiseLast6Months":9744,
"TotalDollarAmountSpentServicesLast6Months":727,
"PurchaseMaxDollarAmount":1949,
"CustomerSinceInMonths":94,
"NumberOfComplaintsLast6Months":1,
"NumberOfSupportTicketsLast4Weeks":14,
"NumberOfMerchansideReturnsLast1Month":7,
"NumberOfServiceCancellationsLast1Month":3,
"TotalNumberOfPurchasesLast6Months":41,
"TotalNumberOfPurchasesLast2Months":1,
"DaysSinceLastPurchase":15,
"PercentageFriendsAlsoCustomers":0.927278065,
"NumberOfComplainsFromFriendsLast6Months":12,
"PercentageFriendsChurnedLast30Days":0.41847703,
"SameAsFriendsTotalNumberPurchases":2,
’NumberWebsiteVisitsLast7Days":5,
"NumberOfDaysSinceLastWebsiteVisit":1,
"NumberWebsitePagesVisitedDuringLastVisit":5,
"PercentageOpenedNewsletters":0.826028182,
"OverallSentimentForLastPurchasedProduct":0.388175661,
"CustomerGender":”M”,
"AvgFriendsAge":34,
"CustomerAge":53}

Functional accelerator artifacts
The Integration Example for Different Predictive Scoring Models functional
accelerator includes the following artifacts.

IBM Integration Bus flow and data files

PCI_ModelIntegration_ZementisChurn_IIB.zip

CustomerChurn_NN_100_rows.csv

scredentials.properties

zcredentials.properties
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Predictive models

PCI_ModelIntegration_ZementisChurn_ Sentiment_CDS_Archive.pes

The IBM SPSS model: SentimentPrediction.str

The Zementis ADAPA engine model: CustomerChurn_NN.pmml

Model data file: SentimentScoreInput.csv

Chapter 1. Integration Example for Different Predictive Scoring Models 5
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Chapter 2. Functional accelerator installation

The Integration Example for Different Predictive Scoring Models functional
accelerator is for use with IBM Predictive Customer Intelligence.

The functional accelerator package contains the following parts:
v IBM Integration Bus flow
v IBM SPSS stream and scoring configuration that is contained in an IBM

Collaboration and Deployment Services repository export
v IBM SPSS stream file
v Model PMML file
v Sample credential files
v Sample data file

To install the functional accelerator, you must perform the following steps:
1. Download the functional accelerator from IBM AnalyticsZone

(www.ibm.com/analyticszone).
2. Import the message flow using IBM Integration Toolkit.
3. Import the sample Churn model.
4. Import the sample Sentiment Score model.

Functional accelerator prerequisites
Before you install the functional accelerator, you must have a fully configured
environment.

You must have administration rights and have the ability to copy files between
computers.

The Zementis ADAPA engine must be installed on IBM WebSphere® Application
Server version 8.5.5.

Download the functional accelerator
You must download the IBM Predictive Customer Intelligence accelerators from
IBM AnalyticsZone.

Procedure
1. Go to IBM AnalyticsZone (www.ibm.com/analyticszone).
2. Click Downloads, and under Predictive Customer Intelligence Accelerators,

click View all PCI downloads.
3. Click More details for the accelerator that you want to download.
4. If you are not signed in, click Sign In to Download.

You must enter your IBM ID. If you do not have an IBM ID, you must register
to create one.

5. Click Download.
6. Go to the directory where you downloaded the functional accelerator.
7. Decompress the file.
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Creating folders and a variable on the Integration Bus node computer
You must create folders and set an environment variable on the IBM Predictive
Customer Intelligence Integration Bus node for the functional accelerator.

Procedure
1. On the Integration Bus node, create a folder in which to copy the message flow

file. This folder will be monitored by IBM Integration Bus. For example, create
a folder that is named C:\IBM\PCIData on Microsoft Windows operating
systems or /OPT/IBM/PCIData on Linux operating systems.

2. Create an environment variable that is named MQSI_FILENODES_ROOT_DIRECTORY
that points to the PCIData directory that you created.

Note: You must restart the Integration Bus node computer after you create the
environment variable.

3. Go to the PCIData folder, and create a folder that is named Zementis.
4. In the Zementis folder, create two more folders:

a. Create one folder that is named restricted.
b. Create another folder that is named error.
You should have the following folder structure:
PCIData

Zementis
restricted
error

Installing and configuring the message flow
You must import the functional accelerator message flow file into the IBM
Integration Toolkit client application.

Procedure
1. Copy the PCI_ModelIntegration_ZementisChurn_IIB.zip from the location

where you decompressed the functional accelerator to a location that is on the
computer where IBM Integration Toolkit is installed.

2. Click Start > All Programs > IBM Integration Toolkit > IBM Integration
Toolkit 9.0.0.1 > Integration Toolkit 9.0.0.1.

3. Ensure that you are using the Integration Development perspective. Click
Window > Open Perspective > Other, select Integration Development, and
click OK.

4. Click File > Import.
5. Select Other > Project Interchange, then browse to and select

PCI_ModelIntegration_ZementisChurn_IIB.zip, and then click Finish.
6. Update the SPSSSentimentSubflow.subflow subflow with the URL for IBM

SPSS Collaboration and Deployment Services.
a. In the Application Development pane, expand ZementisChurn >

SubFlows, and double-click SPSSSentimentSubflow.subflow.
b. Select the SOAP Request - SPSS CADS node.
c. In the Properties pane, click HTTP Transport.
d. Change the Web service URL value to the URL for your IBM SPSS

Collaboration and Deployment Services scoring service.
Enter the URL in the following format: http://hostname:port/scoring/
services/Scoring.HttpV2. Where hostname is the name or IP address of
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the computer where the IBM SPSS Collaboration and Deployment Services
server is installed and port is the port number of the IBM WebSphere
Application Server profile where the IBM SPSS Collaboration and
Deployment Services server is installed. The default port number is 9080.

7. Update the ZementisChurnSubflow.subflow subflow with the URL for the
Zementis ADAPA RPC service.
a. In the Application Development pane, expand ZementisChurn >

SubFlows, and double-click ZementisChurnSubflow.subflow.
b. Select the SOAP Request node.
c. In the Properties pane, click HTTP Transport.
d. Change the Web service URL value to the URL for the Zementis ADAPA

RPC service.
Enter the URL in the following format: http://hostname:port/adapaws/
rpc. Where hostname is the name or IP address of the computer where the
Zementis ADAPA engine is installed and port is the port number of the
IBM WebSphere Application Server profile where the Zementis ADAPA
engine is installed. The default port number is 9080.

8. Copy the files that are named zcredentials.properties and
scredentials.properties from the location where you decompressed the
functional accelerator to the restricted folder that you created.

9. Edit the credentials in the zcredentials.properties file.
a. Open the file that is named zcredentials.properties in a text editor, and

replace uid:pwd with the Base 64 encoded string of the Zementis ADAPA
engine administrative user name and password, separated by a colon and
leaving the word Basic and the quotation marks. For example, if your
uid:pwd is adapa-admin:adapa, then the file should contain:
Authorization,"Basic YWRhcGEtYWRtaW46YWRhcGE="

b. Save and close the file.
10. Edit the credentials in the scredentials.properties file.

a. Open the file that is named scredentials.properties in a text editor, and
replace uid,pwd with the user name and password for a valid IBM SPSS
repository user.

b. Save and close the file.
11. In IBM Integration Toolkit, create a new integration server for deploying the

project.
a. In the Integration Nodes pane, right-click your integration node, and

select New Integration Server.
b. Enter a name for the server, and click OK.

Tip: If IBM Integration Bus is installed on a different computer, you must
connect to a remote integration node.

12. In IBM Integration Toolkit, prepare to deploy the project.
a. Click Project > Clean.
b. Select the project, and click OK.

13. Deploy the project to the integration server.
a. In the Application Development pane, right-click the project, and select

Deploy.
b. Select the integration server that you created, and click Finish.
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Tip: You must redeploy the project any time there is a change to either the
zcredentials.properties or scredentials.properties files.

Installing the sample churn model
You must install the functional accelerator churn model on your Zementis ADAPA
engine.

Procedure
1. Open a web browser.
2. Go to the URL for the Zementis ADAPA administrative console. For example,

go to http://hostname:port/adapaconsole.
Where hostname is the name or IP address of the computer where the Zementis
ADAPA engine is installed and port is the port number of the IBM WebSphere
Application Server profile where the Zementis ADAPA engine is installed. The
default port number is 9080.

3. Log in using your Zementis ADAPA administrator credentials.
4. Click Upload PMML Files.
5. Select Disable upload of multiple files.
6. Click Add File.
7. Browse to and select the file that is named CustomerChurn_NN.PMML.

Importing the sample sentiment score model
You must import the functional accelerator sentiment score model to your IBM
SPSS Modeler instance.

Procedure
1. Copy the PCI_ModelIntegration_ZementisChurn_Sentiment.pes file from the

location where you decompressed the functional accelerator files to a location
that is on the computer where IBM SPSS Deployment Manager is installed.

2. Click Start > All Programs > IBM SPSS Collaboration and Deployment
Services Deployment Manager 6.0 > Deployment Manager 6.0.

3. In the Content Explorer pane, double-click SPSS, and log in as the SPSS
administrator.

4. Right-click Content Repository, and click Import.
5. Browse to and select the PCI_ModelIntegration_ZementisChurn_Sentiment.pes

file.
6. Select the following options:
v Resolve conflicts globally

v Add new version of target item or rename source item, Use labels from
source.

v Continue import even if some objects cannot be imported due to locking
conflicts.

v Resolve Invalid Version Conflicts, Import.
v Resource Definitions, Recommended - Import if there are no Duplicate ID

conflicts or Duplicate Name conflicts.
7. Click OK.

The model is imported along with a scoring configuration that is named
SentimentPrediction.
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Copying the functional accelerator license files to each computer
After you install the functional accelerator, you must copy the license folder to
each computer on which you use the IBM Predictive Customer Intelligence
functional accelerator.

Important: Do not rename the folders or files.

Procedure

Copy the license folder from the folder where you decompressed the functional
accelerator to each computer on which an IBM Predictive Customer Intelligence
component is installed. For example, copy the folder and contents so that you have
a C:\IBM\PCI_IndustryAccelerators\1.0\license folder on Microsoft Windows
operating systems or an /opt/IBM/PCI_IndustryAccelerators/1.0/license folder
on Linux operating systems on each node computer.
The folder contains the license files. The folder should exist on each server and
client node computer.
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Appendix. Troubleshooting a problem

Troubleshooting is a systematic approach to solving a problem. The goal of
troubleshooting is to determine why something does not work as expected and
how to resolve the problem.

Review the following table to help you or customer support resolve a problem.

Table 2. Troubleshooting actions and descriptions

Actions Description

A product fix might be available to resolve
your problem.

Apply all known fix packs, or service levels,
or program temporary fixes (PTF).

Look up error messages by selecting the
product from the IBM Support Portal, and
then typing the error message code into the
Search support box (http://www.ibm.com/
support/entry/portal/).

Error messages give important information
to help you identify the component that is
causing the problem.

Reproduce the problem to ensure that it is
not just a simple error.

If samples are available with the product,
you might try to reproduce the problem by
using the sample data.

Ensure that the installation successfully
finished.

The installation location must contain the
appropriate file structure and the file
permissions. For example, if the product
requires write access to log files, ensure that
the directory has the correct permission.

Review all relevant documentation,
including release notes, technotes, and
proven practices documentation.

Search the IBM Knowledge Center to
determine whether your problem is known,
has a workaround, or if it is already
resolved and documented.

Review recent changes in your computing
environment.

Sometimes installing new software might
cause compatibility issues.

If the items in the table did not guide you to a resolution, you might need to
collect diagnostic data. This data is necessary for an IBM technical-support
representative to effectively troubleshoot and assist you in resolving the problem.
You can also collect diagnostic data and analyze it yourself.

Troubleshooting resources
Troubleshooting resources are sources of information that can help you resolve a
problem that you are having with an IBM product.

Support Portal

The IBM Support Portal is a unified, centralized view of all technical support tools
and information for all IBM systems, software, and services.

The IBM Support Portal lets you access all the IBM support resources from one
place. You can tailor the pages to focus on the information and resources that you
need for problem prevention and faster problem resolution. Familiarize yourself
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with the IBM Support Portal by viewing the demo videos (https://www.ibm.com/
blogs/SPNA/entry/the_ibm_support_portal_videos).

Find the content that you need by selecting your products from the IBM Support
Portal (http://www.ibm.com/support/entry/portal).

Before contacting IBM Support, you will need to collect diagnostic data (system
information, symptoms, log files, traces, and so on) that is required to resolve a
problem. Gathering this information will help to familiarize you with the
troubleshooting process and save you time.

Service request

Service requests are also known as Problem Management Reports (PMRs). Several
methods exist to submit diagnostic information to IBM Software Technical Support.

To open a PMR or to exchange information with technical support, view the IBM
Software Support Exchanging information with Technical Support page
(http://www.ibm.com/software/support/exchangeinfo.html).

Fix Central

Fix Central provides fixes and updates for your system's software, hardware, and
operating system.

Use the pull-down menu to navigate to your product fixes on Fix Central
(http://www.ibm.com/systems/support/fixes/en/fixcentral/help/
getstarted.html). You may also want to view Fix Central help.

IBM developerWorks

IBM developerWorks® provides verified technical information in specific
technology environments.

As a troubleshooting resource, developerWorks provides easy access to the most
popular practices, in addition to videos and other information: developerWorks
(http://www.ibm.com/developerworks).

IBM Redbooks

IBM Redbooks® are developed and published by the IBM International Technical
Support Organization, the ITSO.

IBM Redbooks (http://www.redbooks.ibm.com) provide in-depth guidance about
such topics as installation and configuration and solution implementation.

Software support and RSS feeds

IBM Software Support RSS feeds are a quick, easy, and lightweight format for
monitoring new content added to websites.

After you download an RSS reader or browser plug-in, you can subscribe to IBM
product feeds at IBM Software Support RSS feeds (https://www.ibm.com/
software/support/rss).
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Log files

Log files can help you troubleshoot problems by recording the activities that take
place when you work with a product.

Error messages

The first indication of a problem is often an error message. Error messages contain
information that can be helpful in determining the cause of a problem.
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Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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This Software Offering does not use cookies or other technologies to collect
personally identifiable information.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “ Copyright and
trademark information ” at www.ibm.com/legal/copytrade.shtml.
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